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Introduction to the Rissfox Multisensor  
 

 
Dear customer, 
 
Thank you for purchasing the Rissfox Multisensor - Expansion module for 
the Rissfox Mini by Scanntronik Mugrauer GmbH. 
 
This expansion module for the Rissfox Mini - Data Logger was especially 
developed for recording crack displacements at up to four additional 
measuring points. The cracks that are to be observed are precisely 
monitored with the aid of high-resolution (5 µm = 0.005 mm) analytical 
sensors such that any possible changes can be recognized immediately. 
The readings are directly transmitted to the connected Rissfox Mini (data 
logger system), which is responsible for storing and managing the 
readings. 
 
In addition, the system possesses a flexible and independent alarm output 
with the aid of which, e.g., an SMS alarm message can be sent if any 
excessive movement should be registered by one of the connected crack 
sensors. 
 
If required, it is possible to speedily replace the four standard mignon 
batteries (AA) that are integrated in the Rissfox Multisensor so that any 
pending measuring task can commence without delay. 
 
Within the scope of these operating instructions, we would like to convey 
to you a basic understanding of how to use the Rissfox Multisensor 
expansion module. 
 
The core components for the use of the complete measuring system are 
the data logger hardware (Rissfox Mini), the expansion module (Rissfox 
Multisensor), the crack analysis sensor electronic (up to 1 + 4 = 5 crack 
sensors) as well as the PC software to configure and evaluate the 
complete system. 
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In addition to these, there are further optional components. These are 
amongst others an alarm system for SMS notification, an acoustic alarm, 
etc. However, these components will not be dealt with in detail in the 
context of these instructions. 
 
To be able to set up the data logger and the expansion module for the next 
measuring task as required, it is necessary to install the PC software on 
your computer. With the software you have access, among other things, to 
all of the readings that have been taken and stored in the data logger's 
memory, and you can determine, e.g., the number of active crack sensor 
inputs of the Rissfox Multisensor. For this reason, one of the chapters 
below will deal with how to install the PC software. 
 
When working with the Rissfox Multisensor, please refer to the Rissfox 
Mini instructions as well. The Rissfox Mini, as a data logger, is 
responsible for logging the readings taken and must be configured 
accordingly. This manual only covers the most important functions and 
settings of the Rissfox Mini. 
 

Scope of Supply of the Expansion Module 
 
The package of the expansion will contain the following components: 
 

1. Rissfox Multisensor – Expansion module 
2. AA-Mignon batteries (4 cells) 
3. Magnet for sensor zeroing / tare 
4. Cable for connecting the data logger 
5. Operating instructions for the Rissfox Multisensor 

 
Note: Crack analysis sensors are not included in the package. 

 
If you have purchased the PC software together with the expansion 
module the package also contains the following components: 
 

6. Data carrier (CD ROM) with PC software 
7. PC interface cable 
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Installing the PC Software 
 

Start your computer and wait until the operating system has been 
completely loaded. This may take a couple of minutes. If your computer 
is already switched on, please close all other applications to avoid 
possible conflicts during installation. You now see your operating 
system’s desktop in front of you. 
  

 
 

Figure 1: Desktop 
 

This may be one of the following operating systems: Microsoft 
Windows® 98, NT, Me, 2000, XP, Vista or 7. More recent systems are 
also supported. Now insert the CD with the data logger software in your 
CD drive. Normally, the installation assistant that will accompany you 
through the following installation will start automatically. If it does not, 
your CD drive’s automatic start function has probably been disabled. If 
that is the case, double-click on the “My Computer” symbol to open the 
desktop. Now double-click the symbol of the CD drive that holds the data 
logger software. The installation assistant is started. 
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Follow the instructions on the screen. You first have to specify a directory 
into which the software is to be installed. After that, you can specify the 
name of the folder that is to be created in your start menu during the 
installation process. During the last installation step you are given the 
opportunity to have a direct link created on the desktop and in the start 
bar. Before installation starts, you are provided with an overview of the 
installation options you have selected. 
 

 
 

Figure 2: Installation assistant for the PC software 
 
Once installation has been completed, you can access the software via the 
new entry in the start menu (program “SoftFOX”). After that, the 
program’s welcome screen opens. Press the “O.K.” button to start 
working with the software. 
 
These operating instructions are to explain the exact procedure when 
working with the crack analysis system. Furthermore you will get a good 
overview of the most important software functions. 
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To obtain more detailed information about all of the software’s properties 
and features, open the program’s online help either by means of the “F1” 
button on your keyboard or by means of the menu item “Software - Help” 
under the “Help” menu. 
 

 
 

Figure 3: Accessing the online help function 
 
To be able to use all the functions offered by software, the data logger 
and the expansion module, it makes sense to briefly deal with the online 
help. In this manner, you will learn how to purposefully use the software 
and all other components. 
 

PC Software Configuration 
 
Before the PC software can work in conjunction with the Rissfox 
Multisensor or the data logger, you need to connect the systems to your 
computer. The systems can be connected by means of either a USB cable 
or serial interface cable. Please note the enclosed installation manual 
when plugging in the USB cable, since you must also install the relevant 
interface driver at the same time. 
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Connect one end of the cable to your computer (USB jack or serial COM 
port) and plug the other end into the "Setup" or "PC" jack of your 
electronic measuring system. 
 
Now you need to tell the PC software at which connection port the 
electronic measuring system is linked with the PC. This is done via the 
menu item “Program Settings…” under the “Options” menu. Enter the 
relevant port in the field “Communication Port”. 
 

 
 

Figure 4: Configurating the interface 
 
Once this is done, save the setting with the “OK” button. That way you 
only need to specify the communication port once. The PC software is 
now ready to configure the expansion module and/or read out the data 
logger. 
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Initial Operation and Replacing the 
Batteries of the Rissfox Multisensor 

 
If you would like to put the Rissfox Multisensor into operation for the 
first time or if the system’s batteries are empty, it is very easy to insert 
and/or replace the batteries yourself. To do so, you only need four 
standard 1,5V AA-Mignon batteries and a crosstip (Phillips head) 
screwdriver. 
 
Open the two screw-covers at the left and right side of the Rissfox 
Multisensor housing. After that remove the four screws and open the 
system by lifting the top backwards. The bottom of the housing is 
connected to the top via two flexible links so that the top can’t get lost. 
Remove the four old batteries and insert four new batteries in the 
corresponding holders. 
 

Pay attention to the correct polarity, when inserting the batteries! 
 
If the system is put into operation for the first time, the Rissfox 
Multisensor does of course not yet contain any batteries. Close the system 
housing again, tighten the four screws and protect them with the screw-
covers. Do not use force to open the housing. After installing the four 
batteries, the "System Status LED" lights up and stays on for one second. 
This indicates that the Rissfox Multisensor system was switched on 
successfully. 
 
The "System Status LED" remains off in passive (idle) state, i.e. when the 
Rissfox Multisensor is not taking any readings. If the Rissfox Multisensor 
is connected with the Rissfox Mini, the LED flashes briefly with every 
measurement taken. Typically, that happens every five seconds (“Basis 
Interval” setting). If the batteries in the Rissfox Multisensor are almost 
discharged, the LED stops flashing. In such a case, change all four 
batteries as soon as possible in order to prevent the measuring system 
from failing. 
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Tutorial for the Rissfox Multisensor  
 

Now that you have successfully installed the PC software and inserted 
batteries into the system, the typical procedure to be followed when using 
the Rissfox Multisensor will be explained below. 

 
Every measuring task starts with configurating and testing the measuring 
system. The state of charge of the Rissfox Multisensor batteries should be 
checked first in this connection. This is of particular importance if the 
measuring system is to record measuring data over a longer period of 
time. The system is subsequently configured according to your 
requirements with regard to number of active crack sensors, alarm 
conditions, etc. 
 
To check the status of the batteries, open the configuration window of the 
expansion module by selecting the "Configure Rissfox Multisensor…" 
item in the "Options" menu. 
 

 
 

Figure 5: Configuration window of the Rissfox Multisensor 
 

The field "Status of the Batteries inside of the Extension Module" shows 
whether the batteries have to be replaced or not. 
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Figure 6: Battery indicator of the Rissfox Multisensor  
 

The lifetime of the Rissfox Multisensor batteries directly depends on the 
measurement rhythm, the number of active sensors and the running 
measurement program. We recommend replacing the batteries anyway 
approximately every one to one and a half years. 
 
The "System - Mode" field provides information about the type of crack 
sensors that can be connected to your expansion module. They are 
normally standard sensors with an effective measuring range of 10 mm 
(typically: +/- 5 mm). 
 

  
 

Figure 7: Measuring range of compatible crack sensors 
 

The next step entails the configuration of the individual crack sensor 
inputs. In the window area "Properties of all Crack – Sensor - Inputs", 
you can see a list of the available channels and the relevant sensor 
settings. 

 

 
 

Figure 8: Overview of all inputs and their configuration 
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To modify a sensor input, just click on the corresponding entry in the 
sensor list. The relevant settings are imported in the area "Properties of 
the selected Crack – Sensor – Input” and can be edited there according 
to your needs. 
 

 
 

Figure 9: Configuration area of the selected sensor input 
 
The most important function of every sensor input is whether this 
should be used or not. Switch the corresponding input on or off using 
the check box "Activate the measurement for the sensor input”. Please 
always activate the crack sensor inputs in order, starting with 
"Sensor 1". 
 
The "Zeroing [Digits]" field is a sensor-specific system parameter that 
is saved at the time of the sensor zeroing process (see further below). 
The zeroing value allows the Rissfox Multisensor expansion module to 
define the sensor position as zero point (00.000 mm) when the sensor 
is zeroed. After zeroing, all sensor movements are always interpreted 
in their relation to this zero point. That's why the measurement of all 
connected crack sensors typically starts with 00.000 mm. 
 
The "Execute Zeroing" button is used to initiate the zeroing process of 
a selected sensor input. This defines the current position of the 
connected sensor and the associated zeroing value is imported as 
system parameter.  
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The result of the zeroing process is also indicated directly as new 
button label, among other things. 
 
The "Calibration [Digits]" field is also a sensor-specific system 
parameter that normally should not be changed by the user. The 
calibration value is already defined and configured in the factory, 
during production, for every sensor input and the relevant sensor. 
Since not all sensors are absolutely identical and every sensor has its 
own characteristics, the calibration value can be used to finely adjust 
the respective sensor. 
 
A current measurement of the sensor connected to the selected input 
can be initiated via the "Execute Measurement" button. The result of 
the measurement is displayed directly as a new button label. Please 
note that a changed calibration value is only active after all settings 
have been transmitted to the Rissfox Multisensor expansion module. 
All settings are transmitted with the "OK" button located at the bottom 
right-hand edge of the screen. 
 
You can specify as last function for every sensor input whether alarm 
monitoring should be performed for it or not. To this end, simply 
select the check box "Alarm Surveillance” for the corresponding 
sensor input. The alarm signal is activated via the "Setup / Alarm / 
Switch" port of the Rissfox Multisensor. Many different alarming 
systems such as the “SMS Alarm System” or the “Acoustic Alarm 
System” can be connected to this port. 
 
The relevant alarm condition / alarm threshold for the corresponding 
sensor input is specified via the "Alarm Level [Digits]" field. Just enter 
here the distance from the zero point (00.000 mm) at which an alarm 
should be triggered. It does not matter whether the crack width 
changes in positive or negative direction (+/-) from the zero point. If 
the alarm threshold (“Alarm Level”) is exceeded, an alarm signal is 
emitted via the "Setup / Alarm / Switch" port of the Rissfox 
Multisensor. 
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The alarm signal stops once the crack sensor is within the alarm 
threshold again. You can see the associated “Distance Equivalent” for 
the entered digits under the "Alarm Level [Digits]" field. Change the 
digit value in the upper field, until you get the desired distance 
equivalent, i.e. the desired alarm threshold in mm. 
 
Last but not least, you can also specify a generally applicable delay 
time for the alarm by using the "Alarm Delay" configuration area. If at 
least one of the crack sensor inputs detects an alarm situation, an alarm 
signal is normally emitted immediately. If this is not desired, the alarm 
signal can be delayed for a configurable period of time with the aid of 
the alarm delay. At least, one alarm situation must be present for the 
indicated alarm delay before the alarm is triggered. If all alarm 
situations disappear before the alarm delay has expired, no alarm is 
generated. 
 

 
 

Figure 10: General alarm delay for all sensor inputs 
 

After you have made all settings to suit your requirements, you can 
transmit these to the Rissfox Multisensor by clicking the "OK" button 
on the bottom right-hand edge of the screen. By doing so, the 
configuration of the expansion module is concluded and you can 
disconnect the system from the computer. 
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The next step is to prepare the Rissfox Mini - Data Logger so that it 
can be used with the Rissfox Multisensor expansion module. Use the 
"PC" jack to connect the data logger to the computer and open the 
configuration window by selecting the "Configure Sensors…” item in 
the "Options" menu. 
 

 
 

Figure 11: “Configure Sensors” window of the Rissfox Mini 
 

Since the Rissfox Multisensor is a “Universal – Sensor” expansion 
module for our data loggers, please select the corresponding check box 
in the "Activated Sensors" area. The relevant “Min/Max-Detection” 
can remain deactivated, since this function is not available for the 
Rissfox Multisensor. Click the "OK" button to confirm the changed 
sensor configuration. 
 
For all other settings relating to the Rissfox Mini such as "Configure 
Time / Date”, "Configure Logging Interval", etc., please refer to the 
manual that came with the data logger. 
 
The electronic measuring system is now ready for operation. The next 
step is to mount the crack analysis sensors over the cracks. You can 
connect up to four additional sensors to the Rissfox Multisensor. 
Please note that the sensors are not included in the scope of supply of 
the expansion module.  
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Each crack analysis sensor consists of the following three components: 
 

 
 

Figure 12: Crack sensor and mounting screws 
 

 
 

 
 

Figure 13: Sensor holder (top view and side view) 
 

   
 

Figure 14: Sensor stopper (top view and side view) 
 
The figure below shows the ready-to-use crack analysis sensor 
mounted over the crack. 
 

 
 

Figure 15: Ready-to-use crack analysis sensor (top view) 
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The sensor stopper is mounted on the one side of the crack (here: left), 
the sensor holder is mounted on the other side (here: right). Remove 
the sensor from the holder before you start to mount the holder on the 
wall. Reattach the sensor before you start the measurement task. 
 
To mount the sensor holder as well as the sensor stopper on the wall, 
we recommend the use of the provided two-component wall glue. 
Using glue is uncomplicated and flexible. It is also possible to use 
screws or nails to mount the sensor holder and stopper on the wall. 
Please note that using screws or nails is much more laborious and you 
must assure that all components are solidly attached to the wall. 
 
Mounting the crack analysis sensor on the wall: 
 

1. Remove the sensor from the sensor holder 
2. Clean the bottom side of the sensor holder, the sensor stopper 

as well as the wall surface. All elements have to be dry! 
3. Mix the wall glue thoroughly for about 2-3 minutes. Also see 

glue instructions.  
4. Apply enough glue onto the bottom side of the sensor holder 

and sensor stopper. 
5. Fix the two components on the left and right side of the crack. 

The front side of the sensor stopper has to be clean. Pay 
attention to the distance between the sensor holder and the 
sensor stopper. The optimal distance is 10mm. The front side 
of both components should be parallel as shown below: 
 

 
 

Figure 16: Sensor holder and sensor stopper glued to the wall 
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6. Wait until the glue fixes the components solidly to the wall. 
Mount the crack sensor on the sensor holder using the two 
provided screws. Tighten the screws. The spring born sensor 
nail touches the sensor stopper. Last but not least hook the 
sensor cord into the cord grip. 

 

 
 

Figure 17: Crack sensor with cable screwed to the holder 

 
After all the crack analysis sensors have been mounted over the 
relevant cracks, the sensors have to be connected to the inputs “1. 
Crack Analysis Sensor”, “2. Crack Analysis Sensor”, … of the 
expansion module. 
 
The Rissfox Multisensor provides a so called “zeroing” function (tare 
function) similar to the one of the Rissfox Mini. By this means the 
expansion module starts the analysis of the crack displacements with 
exactly 00.000 mm. 
  
Zeroing is implemented with the aid of the provided magnet. If this is 
kept flat, along the left wall of the housing (not on the decal above), 
until the "System Status LED" flashes one time, the system carries out 
the zeroing process for the first sensor input. Remove the magnet from 
the housing again. If you need to zero another sensor input, place and 
hold the magnet on the housing until the LED flashed as often as the 
number of the relevant sensor input. If the magnet is removed, e.g. 
after blinking three times, the third sensor input had been zeroed. To 
zero all sensor inputs at the same time, place the magnet on the 
housing and hold there until the "System Status LED" blinks five 
times (5x). 
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Last but not least, connect the Rissfox Multisensor to the Rissfox 
Mini. To do so, plug one end of the connection cable into the “Data 
Logger Port” jack of the expansion module and plug the other end of 
the cable into the “PC / Alarm / Switch” jack of the Rissfox Mini. 
 
The system (Rissfox Mini + Rissfox Multisensor) is now measuring 
continuously and stores the measurements in the internal memory of 
the data logger. You may place the measuring system in an arbitrary 
position to use it for your measuring task. 
 
At the end of the measuring task, reconnect the data logger to the 
computer using the “PC” jack and read out the collected 
measurements. You have to disconnect the expansion module before 
you can connect the computer. 
 
Data may be read out either via the menu item “Transfer Data…” 
under the “Toolbox” menu or by clicking on the fourth button of the 
toolbar to the left of the diagram window. 
 

 
 

Figure 18: Read out measuring data 
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Once the measurements have been transferred to the computer, 
they are directly depicted in the form of a clearly laid out diagram. 
You can zoom-in the diagram by using the left mouse button. This 
is interesting and important for the crack curve in particular 
because crack displacements are often very small. By this means 
you can magnify the crack curve. 
 
The measuring unit of the crack curve is millimeter [mm]. If you 
have also recorded climate data in addition to the crack data, the 
unit of the air humidity curve is percent [%rH] and  the unit of the 
air temperature curve is degree Celsius [°C]. 
 
For a correct crack measurement data interpretation please note: 
 
If the measured value of the crack sensor is positive, the crack has 
closed. If the measured value is negative, the crack has opened.  
 
With the aid of the diagram tools to the right of the diagram window, 
you can change the diagram’s appearance. 
 
It is also a good idea to activate the "Diagram Legend" at this 
particular time in order to be able to recognize which measured curve 
belongs to which crack. Since the Rissfox Multisensor is a “Universal- 
Sensor”, the standard curve description of the four connected crack 
analysis sensors is "U1 - Readings" to "U4 - Readings".  
 
To save the data, use the menu item “Save Project As…” under the 
“File” menu. 
 
More detailed information on how to operate the software and 
configure your data logger may be found under the online help 
function. 
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Guarantee Information and Liability  
 
Scanntronik Mugrauer GmbH grants a 24 months guarantee on all its 
data loggers. Recalibration and battery replacement do not form part of 
the scope of guarantee. We will not assume liability for damages 
caused by the improper use or application of our devices. 
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Notes on the Rissfox Multisensor 
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